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Welcome to the latest edition of my monthly Final Cut Studio newsletter for May, 2009.

The goal of this newsletter is to provide information helpful to the professional user of 
Final Cut Pro. This newsletter publishes each month, past issues are now available in 
my store. All software references are to Final Cut Studio 2 unless otherwise noted. 

Please invite your friends to visit my website -- www.larryjordan.biz. There you'll find 
daily tips, latest industry news, over 450 articles and tutorials to help you get the most 
out of Final Cut!
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WRAP-UP

WELCOME

Finally, Spring is here!

April was a very busy month - our podcast, Digital Production BuZZ - traveled to the 2009 NAB Show 
as the official podcast for the event. We produced 12 hours of programming and 37 five-minute news 
briefs. We interviewed over 200 people. And I wrote a blog describing the whole production process. 

The GREAT news is that these programs were syndicated to over 104 website with close to 100,000 
listeners! 

Here's a link to my blog. (I will confess that, when NAB was over, it took me a week to rest up.) 

Here's a link to all our NAB programming.

http://www.larryjordan.biz/nxltrs/@hdtosd
http://www.larryjordan.biz/nxltrs/ntsctopal
http://www.larryjordan.biz/blog
http://www.nabshowbuzz.com/


No sooner was NAB over, than I traveled to New Orleans for a series of seminars on Final Cut Pro. 
Here's a link to our New Orleans trip.

Now, its back to full-time teaching and working on two books for release later this year. Oh, and we are 
starting to plan our fall seminar tour - more on that later.

In the meantime, my mailbox is way too full of interesting things to share, so let's get started.

[ Go to Top. ] 

APPLE RELEASES OS X 10.5.7

On May 13, Apple released the latest upgrade to OS X - version 10.5.7. 

I decided to install it on my MacBook Pro laptop to see how stable it was.

I immediately ran into a problem with LiveType, where I could not format a text clip. Instead of 
displaying characters, it displayed small video clips.

At first, the problem looked like it was related to the FireWire 400 port. However, the REAL culprit was 
that my LiveType data files were not installed on the boot drive - to save space, I had installed them to 
a second hard drive.

Whenever the data files are on the boot drive, LiveType works properly under OS X 10.5.7. When they 
are on a second drive, LiveType can not create text. Very weird.

Then, this morning, I got an email from Corey Beazer, who wrote:

I updated to 10.5.7 two days ago, since I am between projects. Since then, my FCP has 
been freezing up my system constantly, especially when i am using compressor or 
switching between sequences. I've done the usual, trashing preferences and repairing 
permissions and still no luck.

I'm going to try and reinstall Final Cut Studio and if that doesn't work I may have to try 
and install Leopard again. Just thought I'd let you know, Beware of 10.5.7!!

Larry replies: I've asked Corey to keep me informed on what fixes the problem. But this brings up a 
REALLY important point: DON'T be in a hurry to upgrade a system that works.

In fact, I recommend waiting at least 30 days after any update is released, just to be sure everything is 
working OK.

UPDATE - May 19, 2009 

Corey Beazer sent me the following update:

I've narrowed the problem down further. It's only freezing up when I do ANYTHING with 
a sequence that has some Magic Bullet Looks filters in. Haven't found a solution though.

Larry replies: Corey, thanks for the update. 

[ Go to Top. ] 
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LARRY'S PHILOSOPHY ON UPGRADING

Thinking about the OS X update reminds me that upgrades are in our near future. Here's an article I 
wrote awhile ago that provides more details on my philosophy on upgrading.

Click here to read the article. 

[ Go to Top. ] 

REMINDER: BOOKMARK MY BLOG

By the way, if you haven't visited my blog recently, click here to take a 
look. 

While I don't write every day, I do try to keep you informed on our news, 
plus behind-the-scenes gossip.

It's also on our RSS feed, so feel free to bookmark it. Plus, you are 
ALWAYS welcome to add a comment to anything I write! 

[ Go to Top. ] 

TECHNIQUE: USING THE SOUNDTRACK PRO LIMITER FILTER

One of the main reasons I started using Soundtrack Pro for my audio mixes was that it had a filter that 
Final Cut Pro did not. 

Since then, I've done hundreds of hours of audio editing in Soundtrack and have discovered a wealth of 
features that make editing audio in it a breeze. But, for this tutorial, I want to focus on the one feature 
that got me started with the software: the Limiter filter.

In normal situations, the audio level of most sounds bounces rapidly between loud and soft. This 
difference, called "Dynamic Range," is an important characteristic of a sound. A sound with a large 
dynamic range has a large difference between the loudest portion of the sound and the softest.

The problem is that when audio levels change drastically, they can become hard to understand. For this 
reason, it is often a good idea to minimize, or limit, the dynamic range (that is, to reduce the amount of 
difference between the loudest and the softest sounds) of audio you want people to understand -- this 
is especially helpful with speech.

While there is a role for limiting dynamic range in music - for example, to even out the thumps in a bass 
drum - entire libraries have been filled on the subject of when to use limiting, when to use compression, 
and when to leave them both alone when recording music. 

So, for this technique, we are going to look at how to use the Limiter filter to improve the clarity of 
human speech for use in video production.

Note: One last thought before we plunge boldly ahead. Audio is known for having as 
many exceptions to the rule as there are rules. While there are legitimate reasons to 

http://www.larryjordan.biz/articles/lj_upgrade_philosophy.html
httpp://www.larryjordan.biz/blog
http://www.larryjordan.biz/blog
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avoid using the limiter filter in a dramatic situation, in most cases, applying a limiter filter 
to all dialog - especially non-dramatic dialog - will go a long way to improving 
intelligibility. 

WHAT DOES THE FILTER DO?

In brief, the Limiter filter decreases the dynamic range of your audio; thus making the audio it is applied 
to sound louder.

To do this, the Limiter filter "limits" the amount of gain (loudness) applied to a clip based upon how loud 
the clip is. Softer clips get more gain, louder clips get less. The result of this is that the dynamic range is 
reduced and the apparent loudness is increased. What makes this filter especially useful is that it does 
this "dynamically," that is, on an instant-by-instant basis in the clip, rather than by simply changing the 
audio level of the entire clip, which is what normalization does. 

One of the benefits of using the Limiter filter is that when used properly it guarantees that your audio 
will be consistently louder, but not distorted. This "distortion avoidance" is a HUGE benefit to using this 
filter; as opposed to simply dragging the red rubber band higher in the FCP timeline. 

SENDING A FILE FROM FINAL CUT PRO TO SOUNDTRACK PRO

Audio mixing is generally done when the video edit is complete. So, when the time comes to move your 
project from FCP to STP, there's an easy way to do it -- called "Sending."

What sending does is automatically move all your clips from FCP into STP, without having to resort to 
an intermediate conversion format, or coalesce all your clips into a single AIF file. 

Sending is very cool and, even better, very easy.

 

To send a sequence, Control-click the name of the sequence in the Browser and navigate to Send to > 
Soundtrack Pro Multitrack Project. (You could also select the sequence in the Browser and use File 
> Send to > Soundtrack Pro Multitrack Project.)

You send files to Multitrack Projects that you want to mix. You send files to Audio File Projects that 
you want to repair. You can only send one file at at time to an Audio File Project. There is no limit to the 
number of files that can be sent at once to a mix. 



 

This dialog then appears. The default checkboxes are all OK for video, so all you need to do is give the 
transfer file a name and find a place to store it.

On my system, I have a folder in each of my Final Cut Project folders that I use for storing STP project 
files - which is what we are creating here. That way, if I ever need to go back and re-mix a project... Ah, 
let me state this differently... That way, when I always need to go back and re-mix a project, all the files 
are stored in a place I can easily find them. 

WHERE DO YOU APPLY THE FILTER?

Unlike Final Cut which applies effects to individual clips, all effects in Soundtrack Pro are track-based. 
This means filters are applied to entire tracks, rather than just clips. 

While to many Final Cut editors this may seem strange, this approach actually encourages you to think 
about grouping your audio so that similar audio is on the same track. 

For instance, I'll put all my talking head audio on tracks 1 or 2, that way I know where it is and I only 
need to use one filter for all the audio on one track. Here's an article that describes how I organize my 
audio clips during video editing. 

Here are two rules of thumb that can help you decide where to apply a filter:

�●     If a filter is only active when the audio on a track is playing, for example an EQ or Limiter filter, 
assign the filter to the track that contains the audio clips.

�●     If a filter needs to continue after the audio of a clip ends, for example a reverb filter which rings 
out after the end of the audio, put the filter on a Submix track.

http://www.larryjordan.biz/articles/lj_setting_audio_levels.html


If you have a limited number of tracks in your project, say less than a dozen, feel free to apply a filter 
directly to the track containing the audio you want to modify.

If you have a large number of tracks, it is often a better practice to assign tracks to submixes, then 
apply the filter to the Submix track. This reduces the amount of work the CPU needs to do to process 
your audio and, generally, provides you with better control over the effect.

Since the operation of the filter is the same whether it is applied to a track or a Submix, I will illustrate 
how to use the filter by assigning the filter directly to a track.

An aside : I just made a note to myself to write about how to use Submixes in a future 
issue of the newsletter. 

HOW DO YOU APPLY THE FILTER?

My recommendation, at least while you are learning how to use audio filters, is to only apply the Limiter 
filter to tracks with human speech -- narration, voice-over, and talking head tracks. I generally 
recommend against using it for music or sound effects. Applying this philosophy means that your 
human speech should always be louder, and easier to understand, than the music or effects that 
underscore them. 

Here's a spoken audio track, loaded into Soundtrack Pro 2 (though this filter also works the same with 
Soundtrack Pro).

With the track selected, go to the Effects tab in the left pane, select the Dynamic category on the left, 
then double-click Limiter from the list on the right. (Double-clicking applies the filter to the track. You 
can also select the filter and click the Plus key. I'm too impatient for that, I always double-click the name 
of the filter.) 



The Limiter filter interface opens. If you've never seen anything like this before, don't panic! Once you 
understand how this works, you'll love it.

Here are three settings I make to every Limiter filter I apply:

�●     Leave the Lookahead at its default setting of 2.0 ms.
�●     Set the Release to 750 or larger. A setting of 750 ms means that the filter will remain in effect 

for 3/4 of a second after the audio stops. This prevents the filter from rapidly increasing or 
decreasing the background noise -- called "pumping."

�●     If this audio is the sole track in a sequence and there are no other audio tracks, set the Output 
Level to -3 dB. 

�●     If this audio is part of a mix of multiple tracks, set the Output Level to -4.5 dB.

The Output Level sets the maximum gain for a clip. In this image, because this track is the only audio 
track in my sequence, I set the filter so that the loudest ANY part of the clip will ever be is -3 dB.



I use these same settings for all my narration audio.

Now it's time to adjust the filter to make our audio sound great. Grab the Gain slider and, while playing 
your clip, drag it up until the Gain Reduction bar starts to bounce between the 1 - 2 dB markings. (I 
added the red arrow in this screen shot.) 

What you are doing is increasing the gain of the clip dynamically. If the level of your audio at a 
particular point in time is -20 dB, the gain, in this illustration, is raised by 8 dB, so the level of the clip at 
that point in time is increased to -12 dB (-20 + 8).

If the gain of the clip in the next instant is -15 dB, we add the same 8 dB of gain, so that the level in the 
next instant is -7 DB (-15 + 8). 

If the gain of the clip in the next instant is -10 dB, we add 8 dB of gain EXCEPT that the Output Level 
says that the maximum level of the clip can't exceed -3 dB. This means we add 7 dB of gain, and throw 
the rest away. The amount of gain we throw away is indicated by the Gain Reduction bar at the top.

Our goal is to get the Gain Reduction bar to consistently bounce between 1 - 2 dB, meaning we are 
raising the level of the clip so that the peaks just touch -3 dB. The actual amount of Gain you use will 
vary with each sequence, which is why we need to adjust it each time. 

You'll be amazed at how this filter can make your talking heads and narration just soar out over the 
background, without any risk of distortion.

If you have particular settings that you use over and over, click the Show Presets button in the lower 
right corner.

To apply a preset, simply select it from the menu that appears.



To create your own preset, adjust the settings just the way you want, then click the plus button in the 
lower left corner. Give the new preset a name and you can reuse this whenever you want. 

SUMMARY

If all Soundtrack Pro 2 did was this filter, I'd still use it for every mix. The Limiter filter guarantees that 
my audio is nice and loud, yet prevents it from distorting.

Note: In order for the Limiter Filter to guarantee no distortion, it must always be at the 
bottom of any filter stack you create in Soundtrack Pro. In other words, the Limiter filter 
must always be the last filter applied to a track.

Note 2: Click here for a recent article that describes how to prepare your project audio 
for a mix, and the best levels to use when mixing.

UPDATE - May 19, 2009

Jim Jordan asks: 

I would agree with your use of the limiter filter with SoundTrack Pro. How does the new 
feature in FCP 6 compare: Modify > Audio > Apply Normalization Gain? 

Larry replies: Jim, the normalizing filter raises the level of the ENTIRE clip by the same amount. The 
Limiter raises the level of the clip dynamically, that is, softer passages are raised more than louder 
passages.

Both provide protection against distortion.

Dejan Savic writes:

I just wondered if this was not just for the reference level at the start of the tape? I live 
and work in Switzerland, and the Swiss TV asks for the reference sound to be set at -18 
dB; for digital tapes, the mix can exceed this reference sound level by 9 dB, which 
means that the highest sound level can be -9 dB. (For analog you can add 6 dB, which 
means that the highest sound level can reach -12 dB). In France, some broadcasters ask 
for a -20 dB reference sound. Maybe that explains the remark that some programs must 
be set at -20 dBFS?

http://www.larryjordan.biz/articles/lj_setting_audio_levels.html


Larry replies: Dean, you are correct. The -20 dBFS I mentioned refers to the reference tone, not the 
audio level of the program. 

[ Go to Top. ] 

LARRY RELEASES FOUR NEW VIDEO TUTORIALS!

I've just released four more short video tutorials on Final Cut Studio. These are:

�●     More than Two Dozen Unknown and Highly Useful Keyboard Shortcuts for FCP
�●     Ten Things You Can Do to Get FCP to Work More Efficiently
�●     Creating Animated Livetype Text - Fast and Easy 
�●     Learning How to Read Video Scopes in Final Cut Pro 

You can find the complete list of all my video tutorials here.

Since we started releasing these a few months ago, I enjoy watching which ones have proved the most 
popular - because that helps me determine how to modify my seminars and training. In case you are 
curious, my top five most popular tutorials are:

# 12: Preparing Still Images 
# 02: Retouching Video in Photoshop Extended 
# 09: Minimizing the Spinning Beach-ball 
# 01: Exporting an H.264 Movie 
# 17: Reduce Noise From an Audio Clip 

With almost 30 titles to choose from, and priced at only $4.99 each, there's sure to be at least a couple 
that can help you solve the problems you're having.

Not to put too fine a point on it, but I'd be grateful if you could buy a couple. Otherwise, I'll need to start 
charging for this newsletter. By the way, if you have ideas for specific training you'd like to see, drop me 
a note.

[ Go to Top. ] 

TECHNIQUE: CREATING A GLOWING LANTERN EFFECT

Joyce Marcarelli sent me a note recently asking how to create a "light-emanating-from-a-lantern" 
effect.

Easy, I thought... use Light Rays. 

Then, I tried it and discovered it was a lot more complex than I thought. So, I decided to turn this into a 

http://www.larryjordan.biz/training/online_tutorials.html
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tutorial and share it with you.

To get started, here's the effect we will create. You should replace the orange box with whatever 
graphic you wanted to generate the light -- a lantern, headlight, porch light -- whatever. In this case, I'm 
going to use an orange box because its simple.

Here are the steps.

1. In Final Cut, go to the Generator menu in the lower right corner of the Video tab of the Viewer, open 
the Generator menu and create a Square Shape. While you could use any shape, I like how square 
shapes add a stronger edge to a light ray.



2. Create at least two squares (you can use more, if you want a more complex light pattern) and stack 
them on top of each other -- one on V1 and the other on V2.

3. On V3, I created another square to create the lantern. Or you can import whatever graphic you want 
to use as the light source and place it on V3. 

4. Size, color, and position the V3 graphic (remember to double-click it to load it into the Viewer) as you 
wish. 



5. If you are using a graphic with no alpha channel (that is, it is surrounded by a lot of black), apply 
Effects > Video Filters > Key > Luma Key. Set the Key Mode to Key Out Darker (this makes the 
black disappear) and adjust both the Threshold and the Tolerance so that the image looks perfect and 
the background has disappeared.

6. Turn off the green visibility light for V3 so we can see the layers below it.

7. Double-click the V1 square to load it into the Viewer. In the Controls tab, adjust the size and position 
so it is hidden by the image on V3 -- you may need to turn on the V3 visibility light to see how the 
images align. In this case, I set the size to 8 and the softness to 2, just to soften the edges a bit.

8. Select the Timeline, then select the V1 and V2 clips. Apply Effects > Video Filters > Glows > Light 
rays. Double-click the clip to load it into the Viewer.



9. Notice the Center settings. I set the left box, which controls the horizontal position, way outside the 
image to get the long, streaming tail. Then, the right-hand box controls the vertical position, causing the 
light to stream up slightly. Vary these Center settings to get the light to stream in the direction and angle 
you want for your effect. 

Note: You can keyframe the Center settings to get the position of the stream to change 
during playback. There are lots of ways to play with this, so give yourself some time to 
experiment.

10. I used the same image settings in the Controls tab for the clip on V2 - remember to double-click it to 
load it into the Viewer.



11. And the light ray settings that I applied to the V2 clip were similar, but I changed the vertical Center 
setting to allow the two streams to diverge.

12. Here's the last, important, step. Since each track contains both the white light effect and an 
opaque black background, we need to make the black disappear. While this can be done with a key, a 
better way is to use a Composite Mode. Select the V1 clip and apply Modify > Composite Mode > 
Screen. 

13. Then, select the V2 clip and apply Modify > Composite Mode > Screen. (Yup, its the same effect, 
you need to apply it to BOTH tracks.) 

14. Finally, turn on the visibility light for V3 and look at the entire combination. The Screen composite 
mode combines just the lighter pixels in an image, and makes the rest transparent. It also gives us that 
nice highlight where the two streams overlap. 

Thanks, Joyce, for asking the question. This is a nice way to learn about shapes, the light ray filter, and 
composite modes. 

As with all effects, feel free to experiment and see what other effects you can create using these same 



tools! 

[ Go to Top. ] 

GET HELP GROWING YOUR BUSINESS

You don't need me to remind you that times are tough. A while ago, I put together a 30-minute tutorial 
on how to look for work and how to keep clients.

This has been a very popular segment in my recent seminars and I want to remind you about this 
resource. 

This training is focused on the idea that the best way to get a job is to never ask anyone for work. Don't 
ask for a job, ask for an opinion.

If you are new to the industry, or looking to expand your current client base, invest a few dollars and 30 
minutes of your time and watch this training. It can make all the difference you need when looking for 
work.

Click here to learn more or purchase the tutorial. 

GETTING STARTED IN THE BUSINESS

Here's an example of why Growing Your Business can be really helpful - especially if you are just 
starting out. Justin Rhodes writes:

I want to get your opinion on something. I am starting my video company and I do good 
work for Great prices. By good I mean very much better than beginner level, when most 
of my clients would settle for something that was decent. I want to get into a lot of 
weddings etc. What would be a good price to charge for filming and editing these events. 
I know $500 is veryyy cheap, but I just want my prices to be unbeatable. 

The second part to this question, this woman wants me to film an event that would take 
place over the course of a weekend. Dates July 27th to August 2nd. Okay, not only will I 
be shooting for a lot of those days... but I will be editing etc. Okay, here's the kicker, it will 
be in Houston Texas! And I am from Dallas! So really, taking into account where I would 
stay, what I would do... my gas, my travel and all of the etc's... What is a good starting 
point. I wanna charge great prices, but not "stupid" prices. 

Larry replies: Justin, these are great questions, because it shows you want to make a living, not simply 
do all your work for free. You have a choice - you can price yourself "veryyyy cheap" and be unable to 
support yourself in a year or two, or you can price yourself to earn a living and keep doing this for a 
long time to come. Remember, at some point, there will ALWAYS be someone cheaper than you. If all 
you offer is a low price, you have nothing to fall back on when someone else undercuts you. 

Keep in mind that unless you have someone else that likes buying computer gear for you, and your 
food, and rent, and ... at some point, you'll need to the money to do these things for yourself. So, take a 

http://www.larryjordan.biz/app_bin/Store/catalog/index.php?cPath=29_31
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step back and figure out what it takes to do this as a business. 

We start by working at it backwards. Figure out how much money you want to earn - and keep - in a 
year. Say, $30,000.

Assume that as an editor you'll only be employed for half the time -- 26 weeks. (We always hope for 
more, and plan for the worst.) 

Assume you will work a normal work week when you are employed -- 40 hours per week. (This is NOT 
true in real-life, but it helps with the budgeting process. You'll probably work many more hours in a 
week than 40.) 

Multiply the number of weeks you'll be working by the number of hours per week (26 * 40 = 1,040) and 
divide that number into the amount you want to earn (30,000 / 1,040 = $28.84.) 

That is your MINIMUM hourly rate.

Next, you need to charge for your computer gear. Assume that you need to replace all your computer 
and video equipment every year. Divide the total amount you spent to buy your gear by the number of 
working hours we used in this example (1,040). Don't ever get talked into providing your computer gear 
for free. It cost you money to buy it, maintain it, and replace it. None of those are free. 

Finally, you need to tell your client that you will pass through to them all your travel expenses. These do 
not get marked up. If you spent $500 for travel, hotel and food, you charge your client $500, PLUS your 
time, PLUS the costs of using your computer gear. 

UPDATE - May 19, 2009

Shaun Roemich adds:

Larry: I notice you suggest that travel costs be passed along to the client at actual cost in 
your recent response to Justin Rhodes. My standard practice is to either:

�●     Have the client pay all accommodations, travel costs and per diems in advance
�●     Make appropriate arrangements for my travel and accommodations; or
�●     Mark up actual costs slightly to compensate for the fact that I am out of pocket for 

expenses UNLESS I have already collected a deposit.

My position is that I should NEVER be out of pocket for expenses (with the possible 
exception of consumables as I keep stock on hand as a matter of course) as this risks 
allowing the client to use Terms of Payment to buy themselves some extra time to pay, 
essentially passing the carrying costs on to you, the producer.

Your thoughts?

Larry replies: This sounds good to me. This way, the client feels they are in control of all travel-related 
expenses. 

[ Go to Top. ] 
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SHORT NOTES ON NEW RELEASES

With NAB behind us, a ton of new products have been released for the Final Cut market. Here's just a 
short list of products that we've covered in the past, or from smaller companies you may not have heard 
of before.

GeeThree releases software that GREATLY simplifies animating still images.

http://www.geethree.com/slickfx/photomotion/

SmartSound releases SonicFire Pro 5.1 upgrade for Final Cut Pro

http://www.smartsound.com/sonicfire/finalcutpro.html 

Data Robotics releases DroboPro - faster expandable RAID storage

http://www.drobo.com

CrumplePop releases flock of new Final Cut Pro plug-ins

http://toolfarm.stores.yahoo.net/crhaefforfcp.html

Samson Technologies releases Zoom H4N digital recorder

http://www.samsontech.com/main/announcements.cfm 

Digital Juice is Releasing All Sorts of New Stuff (By the way, I'll have a review of some of their newest 
products in next month's issue.)

http://www.digitaljuice.com/

EditShare and Automatic Duck team up to provide media sharing between FCP and Avid systems.

www.editshare.com/index.php?option=com_content&task=view&id=131&Itemid=146

nVeil announces a graphics tool for the artist living within every editor.

http://nveil.storekstudio.com/ 

MWA Nova's flashtransfer teams with Front Porch Digital to provide film transfer and archiving 
solution.

http://www.flashscan8.us/ 

MXF4mac announces support for more MXF video formats.

http://www.mxf4mac.com

Note: For the latest news on our industry, be sure to bookmark the Latest News page of 
the Digital Production BuZZ. We update this almost daily with news from our industry.
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INTERESTING TRIVIA - CNN COMPRESSION

During my recent trip to New Orleans (you can see photos of our seminars here) I spent some time 
chatting with Ken Tillis, a Senior Photojournalist for CNN. 

We were talking about how he sends his files directly to CNN network operations from whatever 
location he's in - using either a satellite feed or direct via the Internet. That process, alone, is worth an 
article at some point in the future.

However, during our talk Ken mentioned that CNN compresses the files that get uploaded to it. Which 
got me wondering about what codec CNN uses to compress its video.

Ken graciously did some checking and discovered they were using a compression system called: 
Streambox. Here's a link that describes this in more detail.

http://www.streambox.com/products/codecs/act_l3_main.html

FYI, Ken also tells me that Streambox makes the streaming video software that allows CNN 
correspondents to be live 'via broadband' from far flung corners of the earth. Thanks, Ken! 

UPDATE - May 19, 2009 

Andy Mees added:

You note in this month's newsletter CNN's use of Streambox for their store and forward 
and live streaming connectivity for field reporting ... thought you may (or may not) want to 
flesh that out by mentioning the other major player in this field, which is Quicklink. 

Their PC based Live H.264 streaming client is awesome, especially on the new BGAN X-
stream service. And their new HD capable (Mac) store and forward client is producing 
some really gorgeous images (uses the Main Concept H.264 codec I believe). Together, 
these guys pretty much dominate the market, and each boasts a pretty darn impressive 
client list. 

Just thought to mention one without the other might be unbalanced. More on Quicklink 
can be found here: http://wwquicklink.tv

And before I get completely off the subject (!) also of interest might be the Streambox's 
recent partnership with Matrox to integrate the MXO2 with their encoding workflows, 
more here: http://www.matrox.com/video/en/press/releases/streambox/

Larry replies: Andy, thanks. 
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SELECTING THE RIGHT HD VIDEO FORMAT FOR YOUR PROJECT

Here's another video tutorial that grew out of my seminars: How do you select the right hard disk and 
video format for your project? 

In this one-hour, six-part video training, I explain what you need to know to avoid problems with your 
hard disks, when FireWire is sufficient and when you need something faster, how to avoid data transfer 
problems with FireWire, then, how to select the right video format for your next project.

It all comes down to making the right choice -- when picking an HD format do you need:

* Small file size? 
* High-quality green-screen keys? 
* Fast output? 
* High-quality compositing? 
* Faster rendering?

Never pick an HD format simply because your friend owns a particular camera! Because the problem is 
that there is no single HD format that meets all those goals! However, unless you know what some of 
the terms and specs mean, you can easily select the wrong format for your project. 

This tutorial is packed with the information you need to avoid mistakes and pick the right format for you.

A small investment in time to learn now now can save you hundreds, even thousands, of dollars later in 
wasted time and shoots.

Click here to learn more.

[ Go to Top. ] 

CONVERTING 16:9 TO 4:3 OR 4:3 TO 16:9

Kit Lammers sent me the following tip:

Recently I needed to covert some footage from 16:9 to 4:3 for playback and wanted to 
make it as easy as possible. Anyway, I found this technique using MPEG StreamClip 
and thought others might like to know about it:

http://nycpostop.wordpress.com/tag/mpeg-streamclip/

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
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This turns a 16:9 video into 4:3 with letterboxing.



This turns a letter-boxed 4:3 video into 16:9.

Larry replies: Thanks, Kit. 

You can find MPEG Streamclip at: www.squared5.com/svideo/mpeg-streamclip-mac.html.
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ADD DIGITAL PRODUCTION BUZZ PODCASTS TO YOUR WEBSITE

http://www.squared5.com/svideo/mpeg-streamclip-mac.html


One of the surprises for me during our recent NAB coverage was the interest we experienced in 
syndicating our NAB Special Reports to websites around the planet. As of the end of April, the Digital 
Production BuZZ was syndicated to over 110 websites, with an audience approaching 100,000 listeners!

So, we decided to offer the same free player to anyone that wants to put the BuZZ on their website. 
There is NO cost to you. 

Digital Production BuZZ is the oldest running podcast talking about digital production, post-production, 
and distribution. We've been on the air for more than eight years and, if you haven't started listening, 
tune in. We have interviews and information you can't find anywhere else. 

To get your FREE copy of the BuZZ Player, visit this page:

www.digitalproductionbuzz.com/Archives/instructions_syndicate_podcasts.php

... copy the HTML code and paste it into your home page.

What you are installing is a simple, free, Flash player that automatically updates each week when we 
create a new show. 

There's no hidden agenda here, we're just looking for ways to get the word out about the BuZZ. You 
can remove the code from your site at any time.

You can see the player in action on my website: www.larryjordan.biz.
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READER MAIL

We have all kinds of questions this month -- so let's see how many we can get answered in this issue.

TIP: REDUCING RENDERING TIME

Don Smith sent in this tip:

I just learned of a trick to reduce rendering time on a single computer (not using other 
computers to "farm out" the processing)...

First, the headlines, then the background.

Using the same timeline and compressing to the same codec with no additional apps 
running other than those noted on an Intel MacPro (4-core) machine:

Running FCP and exporting a 4-minute, 53-second timeline to Compressor and 
compressing using H.264 with 48k audio and retaining the projects frame rate and size: 
1-hour, 34 minutes.

Running FCP, exporting that same 4:53 timeline to a reference movie, QUITTING FCP, 
and then running Compressor using "This Computer": 19 minutes.

http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
http://www.larryjordan.biz/


Running FCP, exporting that same 4:53 timeline to a reference movie, QUITTING FCP, 
and then running Compressor but using a virtual cluster: 13 minutes.

Other than the surprise that the project will render MUCH faster by NOT exporting 
directly to Compressor (on my machine, anyway), I've learned a trick to make your Mac 
think it can compress using networked computers to help.

Go to Preferences>Apple Qmaster and set the following:

�●     If running, first click "Stop Sharing"
�●     Leave "QuickCluster with services" selected.
�●     Highlight the Compressor line in Services
�●     Click "Options for selected service..."
�●     Select the number of instances you want. It appears that you need 1GB of RAM for each 

instance with some left over. I have 13GB of RAM on my machine so I select the maximum of 4 
instances. You can go to 8 on OctoMac if you have MORE than 8GB of RAM it appears. Try 2 
on a laptop with 4GB of RAM. 
 
You can change the name of your cluster to something you like. I chose "Bubba" in my case.

Launch Compressor with the reference movie you want to compress and select your 
compression method and destination, then press Submit.

You'll see a resulting dialog where you select your virtual cluster:



In my tests, WITHOUT FCP running or NOT exporting directly to Compressor from FCP, 
using "This computer" compressed my 4:53 ProRes ProRes 422 422 movie in 19 
minutes. Using my Bubba virtual cluster, my movie compressed in 13 minutes.

I first tried to export directly from FCP and choose virtual cluster but that would simply 
result in FCP become non-responsive and nothing happens. I found others on the 
Internet who also said not to export directly from FCP and instead export to a reference 
or self-contained movie file, quit FCP, and then compress your movie.

Larry replies: Thanks, Don, for sending this in!

UPDATE - May 19, 2009

Gordon Ingliswrites: 

For those who are working on RAIDs and want to cluster two or more computers I'd add 
this; clustering needs you to set up a folder on the RAID for temp render files, the path 
for this folder cannot have any spaces in the name so, for example, 'RAID/render farm' 
will not work, it must be 'RAID/renderfarm'.

And of course the source file needs to be on the RAID as well.  
Clustering is an amazing boost to productivity, just get it working before you need to use, 
don't try to get it running with a deadline looming (like me).

Larry replies: Thanks for adding this, Grodon. 

Don added: 

In case I didn't make it clear enough, my procedure was inspired by a trick I found 
elsewhere. I can't claim to have created it but I improved on how to set it up after a 
couple of hours of testing. The original tip just caused my computer to lock up and do 
nothing but with the appearance of doing something.

As you can see, even after saving a reference file and not exporting directly to 
Compressor to massively improve the rendering time, the Virtual Cluster method 
improved my rendering time yet again over "This Computer" by 31% and I think that 
shrinking your best rendering time by one-third again is worth talking about!
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ANOTHER NOTE ON FASTER RENDERING



Ben Balser writes:

Recently, you wrote that "I don't think there's any significant performance benefits to 
increasing your RAM in multiples of 2, thus, 'doubling' RAM."

Well, truth is, not on a G5, but on an Intel machine it does. The Intel will access RAM 
faster when installed in identical pairs, which is why Apple recommends this, although 
the machine will still work if you don't. Matching pairs will allow the system to access 
RAM faster, but this is an Intel Mac only thing.

Larry replies: Thanks, Ben, for the clarification.
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INCREASING THE LENGTH OF A SLUG

(Sigh.. that's not as ugly as it sounds.)

John Dakin writes:

I want to lengthen the Slug in my Timeline to a project 20 minutes long in order to put a 
Time Code Generator onto my project prior to sending to my client.

Larry replies: John, by default, a slug has a duration of ten seconds and a length of two minutes.

You can change the duration by resetting the In and the Out in the Viewer.

However, to change the length, you'll need to change a preference setting BEFORE you create the slug.

Go to Final Cut Pro > User Settings > Editing tab and change the Still/Freeze Duration to the length 
you need the slug to be.

This must be changed BEFORE you create the slug. Once you've changed this, the rest of the process 
is easy.

UPDATE - May 19, 2009

I go tthis comment from a number of people, including Chris Roberts, Andy Mees, Tom Wolsky, and 
others. 

[Chris wrote]: You mention to adjust the Still/Freeze Duration before creating the slug, 
but this would mean you'd be changing the value for the slug, then changing it back 



again. Instead, I usually create the slug (or any other generator of choice) and then 
adjust the Duration in the top left of the Viewer. Using this, you can create a slug at 
whatever length you want, edit it to the timeline, and all without adjusting the Still / 
Freeze Duration.

Larry replies: Sigh... OK, so I screwed this up. Apparently, the Still/Freeze duration only affects stills 
and freezes (go figure...). Anyway, its nice to know that changing the duration of a slug can be done by 
modifying it's duration in the Viewer -- my apologies for the error.
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ADDING AUDIO REVERB

Andy Wilson, from Scotland, asks:

I have an audio problem which I can't easily get round and I'd be pleased if you could 
help. To end an edited clip of a door-slam for example say I need a large plate reverb 
fading to inf. As there's no timeline space after the cut for the reverb to die out, how can I 
add reverb only to this door-slam in FCP/Soundtrack?

Larry replies: Andy, reverb needs to apply to a clip after it ends. This can't be done by applying the filter 
to a clip. Instead you need to apply the filter to something that CONTAINS the clip. The only way to do 
this is to either manipulate the clip in Soundtrack Pro or create a nest in FCP.

Here's how:

1. In Final Cut Pro you can edit the clip into a new sequence. Add black after the clip that 
is at least as long as the reverb tail you want to create. Then, edit the sequence that 
contains the clip you want to add reverb to into your project.

Apply the reverb filter to the nested sequence (the one that has your clip) and the reverb 
will ring out over the black at the end of the clip.

2. Or, send the clip to Soundtrack Pro as part of your mix. Create a reverb submix and 
apply the filter to the submix track, rather than the track that contains the clip. The reverb 
will then ring out as long after the clip ends as you want.

Reverb is almost always applied to a submix track for exactly this reason.

UPDATE - May 19, 2009

Charlie Wilson writes: 

One comment on the person wondering about reverb and nothing left after the clip, here 
is something I've done for several years that helps with opening the timeline for shuttling 
clips around for later use when building a scratch sequence and general editing. 

When I edied on both AVID and FCP, I noticed that FCP's timeline is not all open like in 
AVID. So to fix this, I have a template sequence with a Valid8 bars for 1 minute, then 
slate and countdown. That's pretty standard, but what i add is about 10 minutes down 
(since I edit news features that rarily go any longer) I put a another 3 second clip of bars. 
This makes the last thing in the timeline NOT freeze at the end or almost fade out. Also I 
can put alternate possible sound bites or broll down stream and grab them later for use. 

Once I showed this to the other editors here at the BBC they all love it and it is standard 



practice. Also that means I have "best rendering" set in the Sequence Settings that is 
defualt to Normal.

Larry replies: Thanks! 
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CREATING A COLOR LOOK

Nando writes:

How can a make my movies look like the color I see in a movie? When I watch Movies I 
can notice that They have a Different Color Than Normal. Is this color That i want to 
know how Can i do on my Projects.

Larry replies: Nando, thanks for writing.

There are lots of answers to your question. Partly the differences are due to how film captures light vs 
how video cameras capture light.

Also, film tends to be a bit underexposed, in video terms, which darkens the highlights.

Another big difference is the lenses - film works with lenses that provide a very shallow depth-of-field, 
causing the rest of the background to go out of focus. This is not possible with the smaller lenses on 
most video cameras. 

Also, depending upon the camera you are using, shooting a progressive image, instead of an interlaced 
image, will also help.

However, the biggest difference between a "film look" and a "video look" is the lighting. In film, it is not 
unusual to take two - three hours to light a single shot.

In terms of matching the color, the Color Corrector 3-way filter can match the color, but it can't 
compensate for these other differences - all of which need to be accomplished during production.

There are many filters that try to make your film look more "filmic." However, they only go so far. The 
best advice is spend time with lighting and exposure.

[ Go to Top. ] 

TWO QUICK QUESTIONS

Richard D'Agular writes:

I come here with two questions you might know the answer to:

1. is there a way to play a sequence on a FULL SCREEN mode? 
2. What is the short cut to alter the Db levels of an audio clip selected on the timeline?

Larry replies: Richard, here are three quick answers:



1. Select View > Video Playback > Digital Cinema Desktop Preview (Main) 
Then, toggle it on using Command+F12 and return using Escape.

2. Select the clip. Press Control+[hyphen] or Control + [equals}

And thanks for writing!

UPDATE - May 18, 2009 

Loren Miller adds:

You should also add this equally handy enhancement: 

Control left or right brackets to lower or raise selected audio by THREE decibels.

Larry replies: Cool. Thanks. 
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WHERE TO STORE FILES

Anna B. writes:

Your tutorials on FCP 6 are invaluable ! I'm going to switch from iMovie to FCP !

Just one question : I understand there's 2 locations : 
- on the boot disk the "FCP Project" folder with everything except medias 
- on the 2nd drive the "Final Cut Pro Document" where FCP will organize everything by 
itself.

That works with "log and captured" media. They go in this "Final Cut Pro Document" 
folder.

But if I'm directly given the clips as .mov. I understand I have to put them on the 2nd 
drive. But where ? Inside this "Final Cut Pro Document" folder ? Or on another folder 
dedicated to this project ? inside or outside this "Final Cut Pro Document" folder?

Larry replies: All media should be stored on your second drive. WHERE you put media that you are 
given, as opposed to captured, is not particularly important, as Final Cut will track it properly -- as long 
as you don't move it once you put it in your Final Cut Project.

My suggestion is to create a folder called "FCP Project Media" on your second drive. Then, store media 
you are given in a folder named after your project INSIDE the FCP Project Media folder.

This whole business of where media gets stored is getting more and more complex as we deal with 
tapeless media and media we create in applications like Adobe After Effects. My hope is that the next 
version of Final Cut will address this. If not, I'll create an article to provide suggestions later this year.
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LOOKING TO MAKE A TRANSITION



Lynn Beittel writes:

I'm looking to buy/find some new transitional effects for FCP. I have the standard ones 
that come with the program. Where would I go to find them?

Larry replies: This is a great way to start a discussion -- verging on argument -- at any Final Cut 
gathering. 

I suggest taking a look at:

�●     GenArts
�●     Boris Continuum

However, I will add other reader's suggestions to this list as well. EVERYONE has an opinion on the 
best place to go for transitions.
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A SOUNDTRACK QUESTION

Eric Hvisc writes:

I do the video taping of a local dance company, and every now and then they ask me to 
do some audio work for them. nothing heavy just extending some music pieces so they 
have enough song to finnish the dance. 

Well, this year I used Soundtrack Pro to do the job. It all went well until I exported the 
audio and try to burn it with iTunes. The error was "iTunes is unable to convert this audio 
to CD format". 

Now I exported it as an AIFF at 44 mh which i believe is the CD format, and it gave me 
the option to send it right to iTunes, so I was surprised it didn't work. I had to open the file 
in Quicktime pro and then export it again as an AIFF and this time it worked. now I don't 
this often but is there a way to export from sound track pro and then burn to standard 
audio CD?

Larry replies: Eric, I've not seen this problem. However, if a reader has a suggestion, I'll post it here.

Although, in thinking more about this, you need to be SURE to export it as a 16-bit, 44.1 kHz AIFF file. 
Soundtrack often defaults to a higher bit-depth, which iTunes doesn't support.

[ Go to Top. ] 

SETTING UP AN AUTOMATIC RECORDING IN SOUNDTRACK PRO

Warren Nelson writes:

I've been looking for a way to stop a recording automatically at a given point time. The 
cycle region would be great, if you could set it up to not cycle but stop at the end of the 
cycle region.

http://www.genarts.com/
http://www.borisfx.com/final_cut_pro/bccfxplug/


I'm transferring a bunch of old records from my dad's collection for him to listen to on CD. 
It would be nice to be able to set a 20 minute region to record, then walk away. I can't 
seem to find that functionality.

Larry replies: I suggested to Warren that he try an End of Project marker. However, Warren told me that 
didn't work.

Hey, thanks for the nearly instant reply!

Here's what doesn't work:

1. End of Project Marker 
2. Cycle Region (keeps cycling so doesn't work in a "walk away" situation.) 
3. Creating a Cycle Region and shutting off Cycle (C) That simply deactivates the whole 
Cycle Region system.

I've been using a program from Roxio call CD Spin Doctor. It lets you predetermine a 
record stop time in increments of 5, 10, 15, 30, 60, 90 minutes. However, most LPs are 
17 to 25 mins a side! And Spin Doctor is extremely unstable. It crashes frequently.

Once I have the AAIF file out of Spin Doctor, move it into Soundtrack Pro to "de-click" it 
(this function works very well) and tweak noise levels, etc.

Then I open it again in Spin Doctor which automatically creates tracks based on the 
silences between the cuts on the LP. This works very well. Then you export the AIFF file 
to iTunes which converts the tracks to AAC and lets you use them in iTunes just like any 
other audio.

Anyway, the workflow works. It's just kind of cumbersome. If I could record to Soundtrack 
Pro, with automatic record stop, do the necessary clean up, move it to Spin Doc to 
create the tracts then move the tracks to iTunes, it would be much more efficient.

Having said all that, this is a personal project and not worth a lot of processor cycles! LOL

Thanks again for your suggestion!

Larry replies: Thanks for the update.
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AVOIDING AUDIO DRIFT

Lillian Wang writes:

Read your recent newsletter with interest, in particular about audio drift using capture 
now. I know it's a really bad habit to do so, but I have to admit that I often use the 
"capture now" button to capture from mini-DV tape, out of convenience.

What I've discovered is, if you hit play on the deck or camera, and then click the "capture 
now" button, stuff stays in sync. But if you click on "capture now" first and then hit play on 
the deck or camera - stuff captures fine, but audio drifts will happen. At least, that's been 
my experience!

Larry replies: Thanks, Lillian, for writing. I'll add this to my collection of tips.
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OUTPUTTING SURROUND SOUND

Richard writes:

Larry can I output a mov file with surround sound other than through DVD studio pro?

Larry replies: Sure - both STP and FCP support it.

However, the only way to compress it into something playable on a DVD player is by using Compressor.
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EXPORTING BROWSER COLUMN DATA

Ryan Moos writes:

Quite some time ago I took your FCP class at Video Symphony. I don't expect you to 
remember me, as you said you were bad with names, and its been some time.

I was hoping you could point me in the right direction. I need to export all of the column 
data from a bin filled with clips and import it into a database. FCP only exports an XML 
batch list of these clips. Is there another way to get the data in a tab delimited text file, or 
excel sheet? If not, do you know how to pull the info out of the XML.

Any guidance would be greatly appreciated!

Larry replies: Ryan, this is easy!

Select all the clips in the Browser that you want to load into your database.

Choose File > Export > Batch List. By default this export is tab-delimited.

You can easily open this file in Excel or import into any database.
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EXPORTING FOR THE BEST QUALITY

Tom Prigge writes:

In your April newsletter, you recommend exporting for DVD by using Quicktime 
Movie at current settings. I have found the same advice elsewhere. BUT I 
have started using Compressor and the Animation codec. I had the other 
commercial producers here (WPSD-TV Paducah, KY) look at DVDs burned with 
the Animation codec and the QT Current Settings. We all agree the DVD 



burned with the Animation Codec looks better. (We have an unusual workflow 
here--we cannot go directly to tape from our desks. I have to make a DVD 
that the tape room plays into a DVC Pro deck.)  

When played back on my computer screen, the QT made with the Animation Codec 
looks fantastic--the one made with Current Settings is fuzzy. I understand that is related 
to viewing interlaced video on a progressive monitor. I even used Compressor 
to make a 10 bit uncompressed QT and even it did not look as good as the one 
made with the Animation Codec. Bottom line: Are our eyes deceiving us? Is 
export to Quicktime Movie at Current Settings really the best?

Larry replies: Tom, thanks for writing.

First, without seeing actual screen shots, this is impossible to completely answer. But, you may be 
comparing apples and oranges here.

It is my opinion that - all other things being equal - outputting using the animation codec does not 
improve final DVD quality when compared to outputting a QuickTime movie using Current Settings - 
provided both are compressed using Compressor.

Compressing in Final Cut Pro does not yield as good a quality.

Also, looking at the QuickTime movie prior to compression will show differences in quality that are not 
evident when the video is compressed.

Here's an article that goes into more detail.
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USING FLIP CAMERA HD FOOTAGE

Terry Colbert writes:

I have a question regarding editing footage that was shot with the pocket "HD" (not true 
HD of course) video cameras that are out there such as Flip's Mino HD camera(http://
www.theflip.com/products_flip_mino.shtml#scene=sceneMinoHD) and Kodak's Zx1 or 
the Zi6, to name a couple (http://www.kodak.com/eknec/PageQuerier.jhtml?pq-
path=14295&pq-locale=en_US&_requestid=9498). 

Do you have or know of anyone (maybe your colleagues or newsletter readers) who has 
experience editing footage shot with these cameras using Final Cut Pro and/or AVID? I 
understand that these cameras record clips as .Movs (H.264 codec) and that according 
to some of the research I've done so far (check out the following blog at http://www.
zarias.com/?p=288 -- also check out his MPEG Streamclip conversion settings tutorial) is 
that in order to get the clips to "play nice" in FCP, it is recommended to download a free 
plug-in "MPEG Streamclip" (http://www.squared5.com/). 

The corporate video facility I work at is documenting an upcoming walk event where in 
order to keep costs low, we are kicking around the idea of supplying two or three of the 
walk participants with one of these types of cameras to document their experiences 
during the day -- sort of as video diaries, but the footage will also supplement ours (we 
will be shooting DVCPRO -- Panasonic HDX-900 and SDX-900 cameras) as stylized b-
roll perhaps. I know that video shot mostly with these cameras are primarily designed for 
the web (which we are also considering) but we would like to include some of it in our 
edited highlight video (16:9, 720p edited program masters). I'm curious if you have any 
thoughts about the cameras themselves in addition to editing footage shot with them. If 

http://www.larryjordan.biz/articles/lj_improve_export_quality.html
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you have time to respond to my email or perhaps post an article about this topic in an 
upcoming newsletter, it would be much appreciated!

Larry replies: Terry, thanks for writing.

The most important thing to check first is whether Final Cut Studio supports these cameras. You can do 
so here: www.apple.com/finalcutstudio/resources.

If your camera is NOT supported, you may still be able to get it to work, but there are no guarantees.

Second, H.264 is a DISTRIBUTION format, it is not an EDITING format. It creates great looking small 
files that can posted easily to the web, but its compression structure makes it VERY hard to use for 
editing.

For this reason, you are best off converting the H.264 video into something more friendly. My 
suggestion would be to use MPEG Streamclip, which is an application, not a plug-in, to convert HD 
footage into either DVCPRO HD or ProRes. (There's no reason to use ProRes HQ, H.264 didn't record 
enough quality to justify the file size.)

You can find MPEG Streamclip here: www.squared5.com/svideo/mpeg-streamclip-mac.html.

One final note - one of the reasons inexpensive cameras are cheap is that they don't 
create file formats that are easy to edit. You'll save money in production, but spend much 
more time in post-production converting and editing the footage.
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CHANGING FINAL CUT'S LOOPING TIME

Mike Keeping writes:

When you are in trim edit and turn looping on (Control L) and press the backslash key, 
the playhead plays back around the edit point continuously. I have been trying to shorten 
the loop time when I set trim looping on in FCP 6. I can't find where I can shorten the 
duration. 

Larry replies: Piece of cake.

Try this and let me know if it works:

* Select Final Cut Pro > User Preferences > Editing tab 
* Change the Pre-roll to the amount of time you want the playhead to back up BEFORE 
the edit point. 
* Change the Post-roll to the amount of time you want the playhead to play AFTER the 
edit point.

If this does what you want, let me know.

Mike added: This works perfectly, thanks!

[ Go to Top. ] 
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CLEANING UP VHS FOOTAGE

Praveen writes:

I have some old VHS tapes shot in 1984 which had a lot of video noise in it. Is there any 
plugin/software to de-noise the video. 

Larry replies: Yup.

* If you have not already captured them, rent/buy a time-base corrector and put it 
between the deck and your computer. This will significantly reduce noise and chroma 
error prior to capture. An inexpensive time-base corrector is made by DataVideo - the 
TBC-1000. http://datavideo.us/tbc-1000.html

* If the video is already captured, you'll need to look for some 3rd party filters to clean 
this up. Final Cut does not ship with any filters that are useful for this.

ToolFarm put together a list of plug-ins that might help, so check here first:

http://toolfarm.com/plugins/index.php/Reduce_Noise,_Grain_and_Artifacting
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GETTING THE RETURN BUTTON TO WORK

Keith Dadley writes:

I went through your lynda.com Essential Training disc for DVD Studio Pro 3 simple DVD 
lessons. First of all, thanks for the frank and informative way you teach. I swear I just 
can't read a manual anymore since video tutorials arrived!

I followed along the lesson with my version 4 as best I could. After ward I created my 
own practice project to do all the steps myself without your guiding hand... going strictly 
on memory. Anyway, I created a Chapter Index button as you instructed. It works just 
great. My problem with the Index Menu is, that it won't make the Simulator return to the 
chapter index when clicking the Menu button. It will always go back to the Main Menu 
instead. I tried to have the chapter index menu Return to that menu by selecting the 
chapter index menu in the Return Button selection. I thought that the Return Button for 
the menu would behave like a track's End Jump... apparently not!

Is there a way for a Chapter Index created menu to return to the Chapter Index instead 
of the Main Menu?

Larry replies: Keith, thanks for writing!

The "Return" button is for the remote control.

Where buttons jump when clicked is determined by the Target setting in the Inspector.

Remember the special wording of a button: "_Prev_" This means that when the Chapter Index is 
created, that button will be automatically programmed to jump to the menu that called it.
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CREATING CHAPTER MARKERS IN H.264 VIDEO

A while back, Ben Balser wrote asking if it was possible to put chapter markers in an H.264 movie.

I'm trying to export videos to H.264, or MPEG-4 Video, or some format for  
download, that will retain chapter markers. I can export my original DVCPRO-HD  
720 masters that retain chapter markers in QT Player. I can export for iPod with  
chapter markers, but the screen size is too small. 

Is there any listing that shows which codecs retain chapter markers from FCP and  
which don't? I'm running lots of tests right now, and the results don't always seem  
to be consistent, depending of it I export from FCP to self-contained QT, then  
recompress in QT Pro, or from FCP via Compressor. 

Stephen Gagne wrote back with an answer:

I frequently send H.264 QuickTime renders to my clients with chapter markers that are 
accessible by a pop-up that appears in the bottom right corner of a Mac QuickTime 
player. Incidentally, we have verified that Mac users who do not have the Pro version of 
the QuickTime player can also access these chapters in their QT player.

Here's the process:

1. Export as QuickTime movie -- Do not use the export choice that includes QuickTime 
Conversion. If you do, your chapters will be gone, at least when you export using H.264.

2. Be sure export using chapter markers is turned on in the pop-up, and that you are 
exporting a self-contained movie. (Larry adds: I've not found this menu choice to be 
reliable. If you have problems, change this to DVD Studio Pro Markers.)



3. Click on the Settings pop-up in this same export dialog box and scroll to the very 
bottom until you reach the last entry, Custom.

4. In the custom dialog that will appear you can set up whatever frame size and codec 
you wish, and select the H.264 compressor. Unfortunately you do not have the option of 
selecting multi-pass H.264 encoding when using this approach, but it's the only way to 
get chapter markers that I know of when exporting from Final Cut Pro to H.264 
QuickTime. 

If you export using File > Export > QuickTime Conversion you can get multipass 
H.264, which has offers the possibility of somewhat higher quality encoding, but you lose 
the chapters.

Hope this helps.

Larry replies: Thanks, Steve, for the technique!
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WANDERING IN THE LAND OF HD

Tim Lab writes:

Recently I went from SD DV to HDV. Now I am not sure why, as I realize that my output 
at present will be SD DVD and projecting the program on screen (auditorium). I thought 
the quality was just automatically going to be better.

You opened my eyes to many things I never considered. 

Since I have come this far; a new Sony HDV DVCAM and Final Cut Studio 2 it might as 
well pay for itself. At this point I am confused as to why I would want to transcode to 
ProRes. I will do no compositing such as green screen. Effects will be Live type, Motion 
or Effect DVDs with photos from CS4. Appreciate any thoughts on this and thanks for 
your time.

Larry replies: Thanks for writing, Tim.

Here's the short answer. If you are shooting all one format of HDV, editing the same format, and 
outputting that format, there's no real benefit to transcoding your work to ProRes.

ProRes is VERY useful when you are trying to combine multiple formats into one program.

However, what is very, VERY useful is doing your rendering in ProRes. While the render file sizes will 
be bigger, the increased quality and significantly better speed (more than 30% faster) make it well 
worth while.



To change the render settings for your sequence, open your sequence in the Timeline, go to Sequence 
> Settings > Render tab and change the codec to Apple ProRes 422.

UPDATE - May 19, 2009

Don Hertz writes: 

This may be common knowledge, but in your newsletter someone asked the question 
about editing in ProRes versus HDV. We shoot and edit natively 90% of our projects in 
the HDV or XDCAM HD formats. However, we have discovered that compressed H264, 
WMV, and Flash files all look substantially better if we export the final edit to ProRes and 
then use the ProRes format for our conversions. We did tests in Squeeze, Compressor, 
and Episode with similar results. Compressed files, especially WMV files looked 
substantially better from the ProRes file. 

You get the same "cleaner" results with other I-frame style codecs too such as 
Uncompressed and Animation but the file size of the ProRes format is much more 
manageable.

Larry replies: Thanks! 
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CONVERTING HD TO SD



Steve Baile, from Pixus, writes:

I'm editing a documentary in FCS V1 which I shot in HDV PAL 1080i. When it's complete 
I plan to export to SD format and burn to DVD and have used the extra pixels I have up 
my sleeve with the 1080 image to crop the image here and there and apply some 
stabilization which will not degrade the final SD image resolution.

My question is, if I wanted to export an HD version at 720P in PAL & NTSC formats that 
may be more interesting to broadcasters, what would be the best way to go about that. Is 
there any way I can check the output on my 720 LCD TV without having a Blu-ray 
Player?

Larry replies: Steve, you have two basic choices:

1) Edit your HD video into an SD timeline - this is the best and easiest way to stabilize, 
crop, and re-frame shots. 
2) Edit your HD video into an HD timeline - this means you are editing at the highest 
possible quality. This is the best choice for broadcast.

When you are done, export using File > Export > QuickTime movie -- and set it to Current Settings.

Then, using Compressor, convert this into all the different formats you need. Don't use FCP as your 
conversion tool.
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CONVERTING NTSC TO PAL

Brian Galford writes:

I have a client who wants a master for a German translation. I created a copy of my 
finished program where all narration is panned to one channel and all music and effects 
are panned to the other channel. 

Can I, need I— make a PAL Quicktime file for the Germans to work with (taking out my 
English narration and substituting German) by simply choosing DV-PAL from the list of 
options in the Quicktime Export window? I tried this once and got many dropped frames.

Larry replies: Yes, but this isn't the best way.

A better way is to export your NTSC program as a self-contained QuickTime movie, then convert it to 
PAL using Compressor.

However, an even better choice is to use Standard Converter from Graeme Nattress (www.nattress.
com).

The best, but most expensive, choice is hardware conversion using a Teranex box - http://www.teranex.
com/ - which you would generally do at a post facility.

Note: You generally get better quality converting from PAL to NTSC than from NTSC to 
PAL. That's because the PAL image is bigger to start with and reducing an image always 
looks better than enlarging it.

UPDATE - May 19, 2009 

http://www.nattress.com/
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Paul Williams writes:

I work in Switzerland and use both NTSC and PAL all the time. You may suggest to 
someone with an NTSC master and a client in Europe that they can provide NTSC 
masters as European DVD players and TVs will play and display both PAL and NTSC 
standard DVDs. This avoids the time and potential loss of quality inherent in uprezzing 
the NTSC file.

Larry replies: Paul, thanks for reminding me - I keep forgetting this.

Lee Berger writes:

In this month's newsletter you advised a reader to clean up noisy VHS tapes with a Time 
Base Corrector. Time base errors are caused by mechanical playback errors that result 
in scan lines beginning at different horizontal positions on the screen. This causes the 
picture to appear unstable. A TBC aligns all of the scan lines to a stable time base. Also 
a TBC will strip and replace the recording's sync and burst which helps stabilize the 
signal.

However a TBC will not necessarily reduce chroma or luma noise inherent in the VHS 
format (some of that noise may have also been added by the camera used to acquire the 
footage). Some TBC's may feature noise reduction and/or detail enhancement circuitry, 
but not the one you recommended. Many TBC's include a proc amp as well. The bottom 
line is that you are correct in recommending a TBC, but not for noise reduction. In the 
reader's case, a noise reduction filter applied after TBC corrected capture would be the 
best recommendation.

Larry replies: Lee, thanks for this additional infomation. I agree, a Proc Amp would help a lot. 

Stuart Math adds: 

In your current FCP Newsletter a reader asked about cleaning up VHS footage. Here’s a 
product you might be interested in: Video Purifier from Innobits - http://www.innobits.com/
purifier.html

I haven’t used it, but it seems promising.

Larry replies: Thanks, I hadn't heard of this. 
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WRAP-UP

Well, that's about it for this month. 

For current news and in-depth interviews on what's happening in our industry, be sure to listen to the 
Digital Production BuZZ every week. In fact, please put the free player on your website! 

�●     Visit our store and buy a couple of our latest tutorials. 
�●     Or, check out my latest video about picking the right HD format for your project. 

Also, continue sending me your comments and questions. I love hearing from you and enjoy the 
conversations that develop around these stories.

http://www.innobits.com/purifier.html
http://www.innobits.com/purifier.html
http://www.digitalproductionbuzz.com/LiveThisWeek
http://www.larryjordan.biz/training/online_tutorials.html
http://www.larryjordan.biz/app_bin/Store/catalog/product_info.php?products_id=110
mailto:larry@larryjordan.biz?subject=Newsletter comments


Until next month, take care, and edit well.

Larry

Subscribe to Larry's FREE

Monthly Newsletter! 

Email:    
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Legal Notes

The newsletter is free -- but does require a subscription. Please invite your friends to sign 
up at www.larryjordan.biz/newsletter.

To unsubscribe, simply send me an email and I'll remove you from the list. This list is not 
sold, rented, or bartered. The only person who knows you are on this list is me.

The information in this newsletter is believed to be accurate at the time of publication. 
However, due to the variety of possible system and software configurations, the author 
assumes no liability in case things go wrong. Please use your best judgment in applying 
these ideas.

The opinions expressed in this newsletter are solely those of the author. This newsletter 
has not been reviewed or sanctioned by Apple or any other third party. All trademarks are 
the property of their respective owners and are mentioned here for editorial purposes only.

Text copyright 2009 by Larry Jordan & Associates, Inc. All rights reserved. This newsletter 
may not be reproduced or published in any way, in whole or in part, without specific 
written permission from the author. 

Links to my home page, blog, or website articles are welcome and don't require prior 
permission. 
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